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Objectives 
After completing this program, the learner will be able to: 
 

 Define property manager terminology 
 

 Explain the basic property manager inquiry process 
 

 Search for and view OHSU Property, Building or Land information 
 

 Search for and view an OHSU Lease document and payment/billing history 
 

 Find an Lease related invoice and view the check payment information  
 

 Find a Customer Account and view the billing and receipt information 
 

 Use the report function to run a Lease Abstract report 
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Chapter 1: Overview 

Oracle Property Manager - Terminology 
 

Lease Types: 
 Double Net: Lease defines which costs the Landlord pays and which costs 

the Tenant pays for maintenance and repairs.  Differs from Triple Net in that 
Tenant does not pay all costs.  

 

 Expense Stop:    Expense Stop is the owners’ share of annual building 
operating expenses mutually agreed upon between Landlord and Tenant.  
This is often expressed as a dollar amount per sq ft. 

 

 Gross: In a Gross lease the Landlord provides services for both the interior 
and exterior premises.  However the costs of these services can be shared 
depending on other paragraphs of the lease. 

 

 Full Service: In a Full Service lease the Landlord provides services for both 
the interior and exterior premises.  However the costs of these services paid 
by the Landlord and are not shared depending on other paragraphs of the 
lease. 

 

 License: Does not convey real property interest to the Tenant, these 
agreements only give permission for limited use of the property. 

 

 Net: Generally Tenant pays rent and one expense. 
 

 Flat Rate:  Such rates are specific rental rates that remain constant that no 
additional charges can be added to the lease. 

 

 Percentage Rent aka Retail:  Rents computed on the basis of an agreed 
upon percentage of sales volume they may be an addition to a base rent.  
Common in retails lease not office leases.  (Starbucks) 
 

 Triple Net:  All costs for repairs and maintenance are the Tenant’s 
responsibility.  (maintenance, utilities, landscaping…etc)   

 

 Base Year aka Expense Pass Throughs:  A lease where additional rent for 
common area maintenance (CAM) is either paid or refund received if the 
expenses exceed or decrease over the first year that common area expenses 
are paid by the Landlord.  E.g. if OHSU moves into a building in January 2007 
and 2007 is the base year identified in lease, OHSU will not pay est. op exp 
as this is the first year that these expenses are being established.  The next 
year the Landlord will give OHSU an est. op exp to pay based off of the actual 
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expenses paid in 2007 plus a % increase for 2008.  At the end of 2008 the 
Landlord will reconcile the actual 2008 against the est. op paid.  OHSU will 
either pay if the actual was higher or receive credit if the expenses decreased 
from the base year. 

 
Adjustments:  Additional payment/credit made to a lease payment. 
 
Amortization:  The gradual elimination of a liability, such as a tenant improvement 
or equipment, in regular payments over a specified period of time. 
 
CAM: Common Area Maintenance 
 
Commencement Date – The date on which a tenant begins paying rent. It may be 
on or after the lease commencement date, but never before the lease 
commencement date. 
 
Depreciation:  Gradual conversion of the cost of a tangible capital asset or fixed 
asset (excluding land because it has unlimited life) into an operational expense over 
the asset’s estimated useful life. 
 
Easement: A right to use the property of another created by grant, reservation, 
agreement, prescription or necessary implication. It is either for the benefit of land 
“appurtenant” such as the right to cross A to get to B, or “ in gross”, such as a public 
utility easement. Since an Easement transfers a property right, Board of Regent 
approval is required for the UCHSC to grant an easement. 
 
Estoppel: A statement concerning the status of an agreement and the performance 
of obligations under the agreement relied upon by a third party in the context of a 
lease, a statement by the tenant stating that the lease is in effect and certifying that 
no rent has been prepaid and that there are no known outstanding defaults by the 
landlord (except those specified). 
 
Hold over: A tenant who retains possession of the premises after the expiration of 
the lease 
 
HVAC: The acronym for heating, ventilating and air conditioning. Refers to the 
equipment used to heat and cool a building. 
 
Insurance:  Risk-transfer mechanism that ensures full or partial financial 
compensation for the loss or damage caused by event(s) beyond the control of the 
insured party.   
 
Lease Commencement Date – The date on which beneficial occupancy 
commences and the legal terms of the lease go into effect. 
 
Monthly Payment:  Payment for rent made for the life of the lease. 
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One Time Payment:  Payment to be made outside the normal rent payment, such 
as for locks, repairs, etc. 
 
Operating Expense: Expense incurred in carrying out a firm’s day to day activities, 
but not directly associated with production.  Operating expenses include payroll, 
sales commissions, employee benefits and pension contributions, transportation and 
travel, amortiazation and depreciation, rent, repairs and taxes, etc… 
 
Prepayment: 1st month rent paid in advance.  Sometimes last month’s rent if stated 
in the lease language. 
 
Pass Throughs - Building and operating expenses that are paid by the tenant under 
the terms of the lease.     
 
Real Property – (1) land and anything permanently affixed to the land, such as 
buildings, fences and those things attached to the buildings, such as light fixtures, 
plumbing and heating fixtures, or other items that would be personal property if not 
attached. (2) May refer to rights in real property as well as the property itself 
 
Recurring Payment:  Monthly payment for rent in the same dollar amount each 
month, for the life of the lease. 
 
Security Deposits:  The amount of collateral a customer deposits when entering 
into a new lease.  
 
Tenant Improvement:  Changes made to the interior of a property by its owner to 
accommodate the needs of a tenant such as floor and wall coverings, ceilings, 
partitions, air conditioning, fire protection and security.  
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Chapter 2: View Lease History 

You can use Oracle Property Manager’s data to manager your properties, to identify a 
property and associate it with a lease in the lease window. 

1)  View Lease Property 

To view a Property setup you can search by either the Property Name or Property Num 
fields. 
 

Steps: 
Login in to the Oracle Navigator 
 
Select View Lease History and click Open 
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The Find Leases from will appear.  
 

 
 

Enter the Lease Name or Lease Number than Click Find. 
 
The Leases form will appear. 
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Click Open 

 
 

This next screen that will appear will summarizes the Property setup.  To drill down further 
into history of this Property, you are able to click on each tab and review the setups. 
 
Each tab will show the data that has been entered in the Property Manager for this property.  
The Details tab shows the Execution, Commencement and Termination of when the lease 
for this property was setup.   This tab also show the default Revenue and Receivable 
accounting string used for this lease billing. 
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Contact Tab shows who the Landlord and Tenant’s names 
 

 

 
Locations tab shows the lease Type, Code and the Usage type for this lease. 
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Insurance tab will show any Insurance certificate information if applicable. 
 
 
 

 
 
 

Rights tab will show if and when a certain lease has language in the lease for any special 
handling or alerts (exp. The option to pick up extra space if it became available, or the dates 
in which the tenant had the right to Relocate, etc) 
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The Obligations tab would show whether the tenant would be Tax Exemption and document 
where in the lease one would refer back to the lease for this information.   
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The Options tab would show  if the tenant had the right to Extend the lease or  had right for 
Eary Termination and the dates they had in which to exercise these options. 
 

 
 

The Billing tab shows what date range was setup to pay this lease and the amount, it would 
also show any one time payments and what these payments were for. 
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The Notes tab is another place used to document any special handling  of this lease. 
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2) Viewing Attached Documents 
 
Steps: 
 
Go to Navigator, select View Lease History 
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The Find Lease form will appear 
 

 
 

Enter the Lease number and click Find 
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The Property Manager will bring back the lease data that has been entered into Property 
Manager. 
 

 

 
 
At this point you are able to click on the Paper Clip on the tool bar.



©CPDRE March 2009 - 19 - Property Manager Inquiry 

This brings all of the attached documents for this lease, 

 

 
 
Some leases may have more Amendments or other Legal documents than can be viewed 
within the first four lines (this would depend upon the age of lease), you are able to scroll 
down to check for additional documents. 
 
Scroll down to see the line/document you want to view and click on the Open Document 
button. 
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You will have to click each line separately to review each document.  
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Chapter 3: View Properties Setup 

View Properties History 
View property history by searching by the Property’s full name or their Lease number.  

Steps: 

Go to Navigator, select View Properties and click Open.  
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The Find Locations form appears 
 
 

 
 
 

Search for a Property using either the Full Property’s Name or Location Code in the 
appropriate field. The most common ways to perform the search include:  
 

 Use the list of values to search for a Customer/Vendor Full Name or 
Location Code 
 

 Select Find 

 
 
 
 

 
 
  
 
 
 
 
 

.  
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You’ve successfully opened a Location Inquiry. You may now review this property history. 
 

 
 

 
 

 
 
 

Click  Open  

 

 
 
Click Open  
 
(Assignments is not available in Inquiry)  
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To review the Details,  
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Chapter 4: Export to Payables and the Associated Payment 
  

Steps: 

 
Go to Navigator, Select Export to Payables and click Open  
 
 
 

 
 
 

Enter the Period Name 
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You must click the Exported box or no data will be returned    
 
 

And click Find 
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1. Search for an Exported Lease using either the Lease Name or PN Number field.  
 

2. Search using a Period Name  
 

You must check the Exported box or no data will be returned.   
 

3. Click  Find  
 
 

 
 

 

4. You’ve successfully queried all of the billings for this vendor in this period of time. 
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You can arrow down to locate a specific invoice (let’s look at Lease Number 1251) and then click on 
the Transactions button. 
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Click Payment Overview button to view more check information. 
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Click on the Invoice Overview button 
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You can also query invoice information from the Property Manager responsibility by going 
Navigator>Invoices>Find Invoices and entering either the Supplier Name or Number 
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Then clicking on the Find button. 
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Chapter 5: Export to Receivables 
 

Steps: 
 

Go to Navigator, Select Export to Receivables and click Open  
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1. Enter the Period Name 
 

 
 

You must click the Exported box or no data will be returned    
 
And click Find 
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1. Search for an Exported Lease using the Lease Name or PN Number field.  
 

2. Enter the a Period Name  
 

You must check the Exported box or no data will be returned.   
 

3. Click  Find  
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4. You have successfully queried all of the billings for customer in this period. 
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Chapter 6: Viewing Invoices in AP module 

 
Go to Navigator, Select Invoices and click Open.  
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You can review your invoices by entering either Supplier Name, Supplier Number, all of 
Property Manager invoices have PN in front of the Invoice Number (this way Accounts 
Payable can easily identify the invoice belongs to the Property Manager module), and enter 
the beginning Date in order to limit your query. 
 
 

Then click Find. 
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Oracle will bring back the lease information.  This will show whether the invoice has be paid. 
 

 
 
 

Clicking on the Holds tab will allow you to see if there was ever any kind of hold on this 
invoice or not. 
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The View Payments Tab will show you how Payment Method, the Document Number 
(check number) Payment Date, GL Date and Payment Amount. 
 

 
 

Click on the Payment Overview button 
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The Payment Overview form will allow you to review where this payment was mailed to, list 
all the invoice paid on this check, and tell you on what date this check had cleared our bank. 
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Chapter 7: Customer Accounts in AR module 
 
 
 
 

In Property Manager Inquiry OHSU 
 
Go to Navigator, Select Customer Accounts and click Open 
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Enter the Customer Num or Customer Name and click Find 
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Select Account Details button 
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Select the Transaction Overview button, or 
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The Details button, or 
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The Activities button. 
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Chapter 8:  Reports  
 
Currently the process in Property Manager Inquiry, you must to the tool bar and click 
View>Requests  

 
 

 
 
Click on Submit a New Request. 
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The Submit a New Request will open up, the default is Single Request  than click OK 
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When the Submit Request form opens,  
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You will need to click in the Name field so that the field will be able to provide you a list of 

values. 
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Ctrl L and the List of Values will open,  

 
 

 
 
Select Lease Abstract Summary Report and click OK button. 
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The Parameters box will appear and you would enter the Lease Number Low 
 

 
 
Oracle will default the Lease Number High. 
 

 
 
You an also change this report so that the report will the Show Distribution lines to Yes. 
 

  
 
Click the OK button. 
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Click the Submit button. 
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Once the report has Completed with Normal you can click on the View Output button to see 
your report, 
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Or you can print a copy of this report to review. 
 
Go To Toolbar>Tools>Reprint\Republish 
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This would open the Parameters for this report. 

 
 

 
 
Enter the lease into Lease Number Low, this same lease number will default into the Lease 
Number High field as well.  
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Also, I would suggest shortening this search by entering a date in the Schedule Date Low 

field, especially if the lease has or will extended over multiple years.    

 
 
 

Click OK, than Submit. 
 
The Requests will appear with your selected report Pending/Running. 
 

 Click the Refresh Data button,  
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When the report is Completed, Click on the View Output button to review the report. 
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Here is a sample of how your report should look. 
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If you are for viewing any lease in Accounts Payables I would select Rent Schedule Details 
Report. 
 

 

 
 
 

 
 
Enter the lease number in the Lease Number Low field and it will default into the Lease 

Number High field.  Enter a selected date you want to query on and click the OK button. 
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Click the Submit button. 
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The Requests will appear with your selected report Pending/Running. 
 

 Click the Refresh Data button to update the request Phase/Status 
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Once this report has completed you may click on the View Output button to review your 

report. 
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On the first page of this report it is showing the Rent payment month of July 2009. 
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Here is a copy of the second page of this report, this report has 14 pages.  
 

 
 
This report is showing all expenses paid to this lease, on this page of the report is showing 

the cable bill paid to Comcast Cable. 

 
 
 
 


